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Changelog 

This list includes select changes and issues addressed in this release since V8.1.5: 

Installation: 

Addressed issue where SQL databases were not always created on new system. 

DVRServer: 

I/O settings saving speedup 

TruStore file system journaling 

Memory management handling improvements and optimizations 

Enabled archiving with freely selectable timespan (for EasyView) 

New activity data (material statistics) data handling mechanism 

Added digest authentication support for the HTTP I/O driver 

Addressed issue for Digital I/O pulse output handling 

Addressed issue of service freeze after deleting camera with CCRiA/CCFiA support 

Addressed issue with network connection encryption 

Addressed multiple issues with connection establishing and closing 

Addressed issue with unnecessary log file messages regarding performance counters 

Addressed multiple issues with recording activity data handling 

Addressed issue with statistics data loading 

Addressed issues with edge storage handling 

Addressed issue with timestamps when client PC in differen timezone 

Addressed issue with Vivotek camera MJPEG codec configuration 

Addressed issues with audio and text data handling 

Addressed issue with server failover not working 

Addressed issue with Schedule I/O exception 

Addressed issue with DVRServer skipping images. 

Addressed issue with Win32 FileTime error messages related to metadata handling. 

Addressed issue with invalid data exception related to hermeneutic motion detection. 

EasyView: 

Enabled text channel exporting for SEF (Ernitec Secure Export Format) 

Removed username/author metadata from ASF clip export 

Addressed issue with EasyView settings saving unhandled exception 

Addressed issue with TruCast use in Windows domain environment 

Addressed issue where sharing bookmarks required exporting rights 

Addressed issue where EasyView plugin instance creation caused EasyView to crash 

Addressed issue with H.264 decoder unloading 

Addressed multiple issues with recording activity data handling 

Addressed issue with archiving to network drive 

Addressed multiple issues with exporting 

Addressed issue with tab switching keyboard shortcuts 

Addressed issue with very large number of bookmarks 

Addressed issue with EasyView VCA visualization configuration parameter value 

handling Addressed issue with EasyView alarm unhandled exception on initial start 

Addressed issue with EasyView archiving unhandled exceptions 

Addressed issue with incorrect volume levels display 

Addressed issue related to audio recording with some Hanwha Wisenet camera models 

Addressed issue with Bosch camera de-warping tilt range 

Addressed issue with VCA visualization 

Addressed issue with EasyViewPlayer attempting to make unnecessary network connections. 

Addressed issue with EasyView auto-hide in full-screen mode. 

Addressed issue with EasyView where switching from live mode to playback, audio did not always stop. In some cases, live 

audio did not start after transition from playback to live mode. 

Addressed issue with EasyView time panel mode setting not being saved/remembered over EasyView re-start. 

Addressed issue with EasyView "Start new single playback failed" errors related to dragging time slider 

Addressed issue with EasyView font handling not releasing memory 

Changed EasyView 4x and 8x speed playback handling to match 16x, 32x and 64x logic: If the required/asked for playback 

speed cannot be achieved (too long image decoding + drawing time on the client PC for the hardware) then EasyView asks 

the server to skip (not send) images. 

New functionality: EasyView Monitor Manager and the Ernitec AVM Operator Console has new support for EasyView Custom 

Roles (restricting, e.g., grid editing, etc.). 
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System Management: 

Allow for easier handling of multiple network drives for material. 

Improvements in audit trail indexing for large systems with lots of audit trail data. 

Addressed issue with Loopback I/O "Default state is closed" checkbox. 

Addressed issue with VCA Configurator not always exiting/closing. 

Addressed issue with IP Camera Finder saving results. 

Addressed issue with change in motion recording scheduling when upgrading. 

Addressed issue with System Manager settings related application unhandled exception. 

Addressed issue with System Manger long-term use unhandled exception. 

Gateway Service: 

Image handling optimization (lower CPU and memory consumption). 

Addressed issue with failed login username or password message (now no longer reveals which one was incorrect). 

Updated memory handling in Gateway SDK (Software Development Kit) sample application TestSDKApplication.exe. 

Miscellaneous driver updates and other changes 

 
 

New Features in V8.1 

There is a new, shorter timers available for PTZ tour programs (1,2,3 and 4 seconds) 

Diagnostic tool to observe EASYVIEW server loaf: If the system is overloaded, it will skip frames either in image processing or in network 

send. The tool allows to monitor the behavior of the server and re-adjust camera settings to be lower in case of an overloaded situation: 

 

 
Option to Improve data encryption between system components - all client-to-server and server-to-server communications compressed 

and encrypted with connection-specific keys (256 bit AES) on top of existing sensitive data encryption (256 bit AES). 

EasyView Help and User Guide updated for English and Finnish languages. 

System Manager Help and Administration Guide updated for English and Finnish languages. 

It is possible to enable login window site selection from System Manager General settings. 
 

 
Keyboard shortcuts for controlling the view components modes.The shortcut will cycle between the different view modes: hidden, normal, 

large and autohide (when availalble)). The shortcut is also shown as a mouseover hint in the view menu: 

Time slider: Ctrl+Alt+T 

Playback controls: Ctrl+Alt+C 

Device tree: Ctrl+Alt+D 



Alarm list: Ctrl+Alt+A 

Tabs: Ctrl+Alt+V 

 

 
Small controls to the right of Playback panel and Time Slider to control the button configuration and Time slider configuration: 

 

 

 
Playback panel 

Control of the view mode 

Choosing of the control configuration: date, time, activity, frame step controls, speed slider, quick bookmark button, cameratour 

controls and tab change controls 
 

 
 

Time slider: 

Control of the view mode 

Zoom level 

Bookmark display control (moved here from EasyView settings) 

Alarm display control and filter which alarms are shown in time slider. 



 
 

 

Dynamic camera administration in System Manager - improved control of the camera settings without the need to edit camera-driver 

specific configuration files. (Currently available only for select camera manufacturers.) 

 

 

AVM Operator Console plugin can now be paced into a camera grid cell. 

TruStream - dynamic stream selection - now also allows a multi-stream connection to form even if the image aspect ratio changes with 

the other stream. NOTE: This can lead to some flickering in non-fixed image grids. If this is seen as disturbing, the stream setting for 

this camera can be set to be something else than automatic. 

Clients support now logging-in to multiple different 32- and 64-bit servers 

Users do not have to uninstall EASYVIEW or use two PCs to simultaneously use 32- bit and 64-bit servers any longer 

EasyView Multi-master Support - EasyView can connect to multiple Master Servers (SMServer instances) simultaneously 

Using of this feature requires: 

EasyView and primary Master Server must be V8.1, or later 

Client reinstall (uninstall previous EASYVIEW or EasyView and install with the new installer 

again) Master Server license must be be updated with the multi-master feature 

The user can connect to a single Master Server without updating the license. But trying to start an additional EasyView 

to run concurrently to the first one, requires the additional Master Servers to have the license value activated. 



 

One a EasyView window is connected to one Master, additional EasyView windows can be connected to additional 

Masters Layouts and settings will be managed per server, so activating layouts for one server only updates the EasyView 

windows that were logged in to that server. 

Pressing the "Delete" key during EasyView start displays the Master Server selection screen 

 

The Ernitec EASYVIEW application launcher and updater (VAU) can also be used with command line parameters: 

"-c EasyView.xml -a 192.168.100.22 -p 5108" will start EasyView forcing it to logon to server 192.168.100.22:5108 



 

EasyView can have a dark or light color scheme (only in Ernitec EASYVIEW V8 Entegra) 

 
 

Alarm colors can be customized in System Manager for each alarm separately 

 



 
 
 

 

I/O or Audio can exist in a grid cell (taking over the whole cell) 

 
 
 

The Activity panel (time slider) can have two display modes: 

Normal (compact) mode: Activity, bookmarks and alarms are all on top of each other in single bar (new) 

 
Full (expanded) mode: Activity, bookmarks and alarms are separated into three different bars (like before) 



 

The user can toggle the visibility states with CTRL + ALT + T (off / large / normal) 

 
The EasyView numeric keypad popup dialog can be moved to a position on the screen that user prefers (with mouse drag and drop): 

 

System Manager now hides the camera passwords until the "Show password" checkbox is selected: 

 

The PTZ/dome control has been changed to cover less of the video material when the PTZ control is active: 



 
 
 
 
 
 
 
 
 
 
 
 

Advanced use: The PTZ control size can be controlled from the EasyView.exe.config XML file (located in 

c:\users\[user]\appdata\roaming\dEasyView\EasyView\[EasyView version = 8.1.1 64bit]\ folder – value DomeIconSize). Making 

the value zero, will make the control invisible. 

Note that always after changing the value in the EasyView.exe.config XML file, EasyView must be restarted. 

 
Failover recovery is now easier than before: The recommended recovery mechanism is still to restore the system with a known backup 

file, but now the restore dialog has the option to force automatic backup to be run right after a successful restore. This generates a fresh 

system backup so as to make it possible for the failover to work during the same day after the restore, without the need for manually 

performing a forced automatic backup, or copying a backup file to the automatic backup directory. 
 

 
New TruStream dynamic stream selection feature: When the camera is configured with multiple streams, it is now a default option for 

EasyView to use any appropriate resolution stream when the camera is displayed smaller than full size in the camera grid. 

 

 

 

As soon as the camera is expanded to large view, or the camera quickzoom is used, the image automatically switches to a higher resolution 

stream. This feature will save lot of bandwidth from server to client and will make image drawing smoother. 



Version 8 Introduction 

 
The schedule and release content for future releases remains subject to change without notice! 

The main design drivers for Ernitec EASYVIEW Version 8 are: 

Unsurpassed usability 

Significantly reduced cost of installation, configuration and operation with several features designed to ease server management 

World-class integration; connects to any system 

Use-anywhere access with browser based HTML usage (both for video surveillance and for administration) 

Unlimited high performance storage (Ernitec TruStore) 

Unlimited system size (amount of servers and cameras) 

Unlimited flexibility in assigning cameras to server resources 

Single system license, removing the need to maintain individual server licenses ( 

Backwards compatible with earlier Ernitec EASYVIEW servers (V6 and V7) 

The full features of version 8 will be realized in three major delivery steps during 2017 and 2018: 

Version 8.0: Available March 2017 

Version 8.1: Available June 2017 

Version 8.4: Targeted release 4th quarter, 2017 

Version 8.5: Targeted release 1st quarter, 2018 

Version 8.9: Targeted release 2nd half, 2018 

Version 8.0 contains: 

Ernitec TruStore: Unlimited storage drive size with excellent robustness and performance 

New, modern Ernitec EasyView look and feel with efficient operation and world class usability 

Smart Event Management connectivity solution 

Version 8.4 will introduce: 

HTML clients for users and administrators 

Single system license 

Features designed to significantly ease the system install and administration. 

System capacity increase for maximum 200 servers 

 
 

New Features In V8.0 
 

Ernitec TruStore 
 

Ernitec TruStore is designed to meet the challenging requirements of the modern, high-resolution camera streams. The new storage solution 

allows to use any size hard disks for storage, and there is no limit on the amount of storage a single server can handle. The system is also more 

tolerant to connectivity issues to the hard disks. A momentary write failure will not impact the system in the long term. 

In the future, more features will be developed for Ernitec TruStore, for example the ability to block material from being deleted or the control of 

certain devices writing to certain drives. 

Ernitec TruStore is not compatible with the earlier storage format, so if an existing server is upgraded, the material will be lost. It is therefore 

strongly recommended to archive material before a server upgrade. 

 

Compatible With V6 and V7 Ernitec Servers 
 

Users can start using V8 very easily, because the V8 Master Server can support both V6 and V7 networked EASYVIEW servers. In an existing V6 

or V7 system, only the Master Server and client applications need to be upgraded to V8 in order to start utilizing new features. 

 

V8 License 
 

Version 8.0 and 8.1 do not yet use a single system license. The Master Server and V8 EASYVIEW servers still require individual licenses in V8.0 

and V8.1. 

 

New Application Icons 



 
 

New Camera Support 
 

H. 5/HEVC video enoding format support. 

H.265 reduces camera bandwidth and storage space requirements between 40% to 60% depending on the case. 

Mobotix MxPEG encoding format support support 

Support for any model 360 degree cameras with OpenCV based image de-warping 

 

New Look and Feel for EasyView 
 

The EasyView client User Interface has been modernized and redesigned to offer greater usability and effectiveness; 50% more space is now 

given to the camera viewing area. 

 
 

Title Bar Menu 
 

Several features have been relocated to a new title bar menu: 

 
The File menu can be used to open new windows and tabs, access media and open settings, as well as log off and exit: 

 

The Alarms menu offers access to Alarm view and Alarm popup tabs: 

 

The Search menu has all the search plugins (Alarm search, Motion search, Text data search & Thumbnail search): 



 
The Devices menu has camera, IO and layout number control and joystick settings: 

 

The Profiles menu can be used to switch between profiles: 
 

The Layouts menu offers access to layouts, saving a new layout and the layout management (editing) view: 
 

The View menu allows to change the window zoom level, edit camera grids, and control the individual view components visibility: 
 

EasyView plugins can be opened from the Plugins menu: 

 
.The right top corner now has a system status message icon: 



 
The Help menu is unchanged in V8. 

 
 

Device Tree 

In addition to the devices, the device tree now has also a tree of: 

Layouts, 

Plugins, 

Bookmarks, and 

Saved tabs 

The text filter field will work on all of the device tree content: 
 

Layouts and bookmarks can be managed directly from the tree. Opening a layout or a bookmark works with a double-click: 
 

EasyView plugins can be opened with a double-click (opens a new plugin tab) or by drag and drop (opens the plugin to the target camera grid cell): 
 

Saved tabs can also be opened with a double-click. 



Activity and Playback 
 

The activity panel and playback panels are now separated, so that they can be individually either shown or hidden: 
 

The Playback panel has three different size options. 

Normal (default): 

 
Large (contains activity selector, speed slider and camera tour controls): 

 

 
 

Minimized: 
 

. 

In contrast to before, also tab control visibility can be defined. 
 

The Auto-hide can be used to take the window automatically to full-screen mode. The full-screen mode will automatically drop back to normal 

when mouse or keyboard is used. When auto-hide is not used, the window will go to full-screen mode by pressing of the F11 key. The fulls-creen 

mode can be exited with Escape key. 



 

 

Exporting 
 

The camera export is achieved now by dragging the camera on top of the time slider. 
 

The export control box is now only displayed if there is content to be exported. 
 

 
 

Window Placement 
 

In general , the EasyView window can be now made much smaller than before, the minimum window size is 640 x 480: 
 



 

This is especially useful if the window auto-hide feature is used. The camera window can now be arranged to appear full-screen when in a small 

individual window. Such individual windows can also be tiled on the screen, giving 4 different EasyView windows appearing as a camera grid. 

This makes it possible to have multiple playback times on the same monitor. 

The EasyView image can also be stretched to multiple monitors by stretching the window size. 

 
 

Alarm Visualisation 
 

Alarms can now be visualised in the activity panel: 
 

They can be accessed by right clicking the alarm bar: 
 

The visibility and the highlight colors can be controlled from EasyView Settings: 



 

 

Bookmarking 
 

The Quick bookmark button makes a bookmark of the currently played time and content. 
 

 
 

Activity Data Cache 
 

It is now possible to cache the camera and alarm activity data to the client for faster access. It is also possible to do continuous background 

activity data updates, not only when camera is viewed. Such background updates will mean that activity graph is drawn much faster than before. 

This setting is controlled from EasyView settings. 
 



Alarm Comments 
 

Alarms can be commented in the Alarm search plugin: 
 

 

Alarm Filtering 
 

The Alarm popup tab can be filtered to show only specific alarms. This enables users to configure multiple alarm monitors which show only certain 

alarms. 
 

 



 

 

Image Scaling 

Finally, it is possible to set EasyView to use two different image scaling 

algorithms: Best performance (default) 

Best appearance (choose "Enable smooth video scaling" option in Advanced setting 
 

 
 

New Look and Feel to System Manager 
 

System manager gets similar look and feel as EasyView: 
 

 

 

Notes on Upgrading 

If you are using VCA (Video Content Analytics) on a V5 or a V6 server, the VCA license must be updated. It is recommended to take the 

VCA Configurator HWGUID from the earlier version, and contact Ernitec sales for a new VCA license prior to installation of V8. 

Recommended method of upgrading a server to V8: 

1. Still, with the old software version; create a system settings backup in System Manager. 

2. Have the new V8 license ready. 

3. Recommended to use "Full" installer 

4. Start the V8 installer and install the new EASYVIEW version on top of the previous installation. (alternatively you can 

uninstall the previous version EASYVIEW and then start the V8 installer) 



5. When the installer asks for a license, give the V8 license. 

It is also possible to upgrade via the System Manager - "Upgrade recorders" tool. In this case, first upgrade each server's license to a V8 

license, and then use the "Upgrade recorders" tool. Please note that upgrading from V7.5.x or earlier version will format the storage 

drives, causing the stored material to be emptied. 

It is possible that layouts generated with previous versions of EasyView do not work 100% with latest V8 EasyView because of some 

changes done to the user interface. Some re-adjustment of the layouts might be needed. 

The old "EasyView Mobile" does not support Apple iOS 11, or later versions, on Apple iPhone or iPad devices. Use the newer "EasyView 

Seven", instead (requires Ernitec EASYVIEW V7, or later). 

For details, see the Ernitec EASYVIEW Installation Guide. 
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